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Simcenter Femap Roadmap – Updated Release Cadence

Feature Release Every Six Months
Database Change, UI Updates including 

Localization, Licensing Updates – January & June

Maintenance Release 1 
Database, UI, Licensing Unchanged

Bug Fixes/Critical Updates Only

Maintenance Release 2/3 – If Required
Database, UI, Licensing Unchanged

Bug Fixes/Critical Updates Only

Six Month

Cycle
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Xcelerator Share



Xcelerator Share – Overview

Xcelerator Share, Siemens next-generation, 

cloud-based collaboration solution, is now 

integrated with Simcenter Femap 2022.2.  

• Instantly, securely, and easily collaborate with 

colleagues, partners and customers

• Xcelerator Share is the first cloud component 

of our Xcelerator as a Service (XaaS) 

subscriptions

• Not a standalone product. It’s also not a 

replacement of the stand-alone Simcenter 

Femap product.

• Simcenter Femap XaaS brings everything 

familiar about Simcenter Femap, with the 

benefits of cloud services through a SaaS 

subscription option – making Xcelerator more 

accessible, flexible and scalable.
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Xcelerator Share – Overview
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Xcelerator Share – Femap Workflow

Import Simcenter Nastran input file from Share 

project directly into Femap



Xcelerator Share – JT File Export from Femap (enhanced for v2021.2)

JT visualization files can be exported using the 

File->Picture-Save JT command



Xcelerator Share – JT Files

JT files can be visualized in Xcelerator Share, JT2Go desktop, or JT2Go mobile app



Xcelerator Share – Femap Neutral Output Export

To reduce size and/or create a high-performance output file, 

which can potentially be used with Xcelerator Share, 

Femap Neutral Output files (*.FNO) can now easily be 

generated by Femap

• File->Export->Femap Neutral Output command

• Direct Output To section – Specify location and File Name

• Option to Include Neutral File containing only entities 

which correspond to an exported *.FNO file

• Export Options section – 3 Options control how much of 

model is exported for selected output vectors

• Full Model – Output is exported for entire model

• Select Group(s) – Output is exported for nodes and/or 

elements found in any number of selected groups

• Select Elements – Output is exported for selected 

elements and nodes associated with those elements



Laminates Enhancements



Laminate Enhancements – Overview

Several enhancements have been implemented for creation 

and modification of laminates in Femap 2022.2:

• Model->Laminates submenu replaces Model->Layup

• Layup Manager

• User-Friendly and More Intuitive

• Powerful New Capabilities

• Promotes Re-use of Data (Layups and Ply Layups)

• Ply Material Manager – New for 2022.2!

• Ply Material entities which ensure Thickness, Material, 

and Failure Theory on a predefined ply.

• Any Number can be Referenced within a Layup

• MultiLayup Editor – New for 2022.2!

• Allows Multiple Layups to be viewed side-by-side

• Helpful to add, delete, or insert a ply into multiple layups



Laminate Enhancements – Layup Manager – General

Enhancements to Layup Manager:

• Icons Across Top Row

• Opens Ply Material Manager

• Creates Material

• Opens Global Ply Manager

• Copy/Paste Options section

• Send to Excel

• Layup Viewer

• Compute Laminate Properties

• Clear All Column Filters

• Icons Down Left Side

• Insert Ply at Top/Above Selected/Bottom

• Move Plies Up/Down

• Delete Plies



Laminate Enhancements – Layup Manager – Individual Cells

Enhancements to Layup Manager:

• Cells – Text can be edited, or 

available options/entities selected via 

drop-down in each individual cell

• Cells – Context-Sensitive menu

• Set as Default or No Default Row

• Edit Selected Values – updates any 

number of cells in the same column 

with the entered value

• Remove Global Ply ID – removes 

the global ply from the row of the 

highlighted cell

• Show Selected Plys – highlights all 

elements which use the selected 

plies in graphics window



Laminate Enhancements – Layup Manager – Ply Types

Enhancements to Layup Manager:

• Ply Type can now be specified

• Ply

• Ply Material (predefined ply)

• Layup

• Layup – Symmetric (ply order of 

layup reversed)

• Layup – Anti (angles of layup 

reversed)

• Layup – Anti-Symmetric (ply 

order and angled or layup 

reversed)

• Matched Plies – new ply can be 

linked to an existing ply of any type 



Laminate Enhancements – Layup Manager – Columns

Enhancements to Layup Manager:

• Columns – Context-Sensitive menu

• Show Ply On/Off Column

• Show Global Ply ID Column

• Show Ply Failure Column

• Columns – On/Off Column

• When column is visible, items in 

list can be toggled On/Off

• Only items which are On will be 

exported to analysis input file

• Columns – Filter Rows based on 

Material, Global Ply, Thickness, 

and/or Angle using Numerical Value 

(Above, Below, Equal, Outside, 

Between) or Contains (Text)



Laminate Enhancements – Layup Manager – Rows

Enhancements to Layup Manager:

• Rows – Context-Sensitive menu

• Set as Default or No Default Row

• Show Selected Plys – highlights 

all elements which use the 

selected plies in graphics window

• Reverse – reverses order of 

selected plies (only available when 

multiple plies are selected) 

• Rotate – changes Angle by value

• Remove Link – removes reference 

for ‘matched’ plies or layups

• Convert to Plys – converts a 

referenced layup into individual 

plies



Laminate Enhancements – Layup Manager – Rows (continued)

Enhancements to Layup Manager:

• Rows – Context-Sensitive menu

• Convert to Ply Material – saves 

the selected plies as new Ply 

Material(s) or updates plies to 

existing Ply Material(s) which have 

matching Material and Thickness 

values

• Save and Convert to Layup –

saves the selected plies as a 

layup and converts them to Layup 

in current layup

• Convert Referenced Layup –

converts an existing layup into 

another type of layup



Laminate Enhancements – Layup Manager – Rows (continued)

Enhancements to Layup Manager:

• Rows – Context-Sensitive menu

• Insert Layup – Inserts a Layup At 

Top, Above Selection, Below 

Selection, or At Bottom

• Copy – Copies selected rows to 

the clipboard

• Paste – Pastes rows on clipboard 

into the layup with options

• As Matched Plys – if on, pasted 

Plies, Ply Materials, or Layups 

are ‘linked’ to original entities

• Inserts plies at a specified 

location using Matched Order, as 

Symmetric, or as Antisymmetric



Laminate Enhancements – Layup Manager – Example

Layup Manager populated with a Ply, “Matched Ply”, referenced Ply Material, and referenced Layups



Laminate Enhancements – Ply Material Manager

New entity type for Femap 2022.2!

• Model->Laminates->Ply Material Manager 

or Ply Material Manager icon in the Layup 

Manager opens Ply Material Manager 

• Creates and edits Ply Materials

• Specify ID, Title, Material, Thickness, and 

optionally Ply Failure Theory

• Unique icons for Ply Material Manager

• Renumber – one Ply Material at a time

• Show Ply Material – highlights elements 

which use selected Ply Materials in the 

graphics window 

• Similar icons to Layup Manager for 

Copy/Paste (no options), Send to Accel, 

Add Ply (always at bottom), and Delete



Laminate Enhancements – Global Ply Manager

New look and feel for Femap 2022.2!

• Model->Laminates->Global Ply Manager 

or Global Ply Manager icon in the Layup 

Manager opens Global Ply Manager 

• Creates and edits Global Plies

• Specify ID, Title, Material, and Thickness

• Option to Validate Global Ply assignment

• Unique icons for Ply Material Manager

• Renumber – one Global Ply at a time

• Show Global Ply – highlights elements 

which use selected Global Plies in the 

graphics window 

• Similar icons to Layup Manager for 

Copy/Paste (no options), Send to Accel, 

Add Ply (always at bottom), and Delete



Laminate Enhancements – MultiLayup Editor – General

New command for Femap 2022.2!

• Model->Laminates->MultiLayup Editor

• Allows any number of layups to be 

compared to one another side-by-side

• Two modes available, both automatically 

update all layups needed for update

• Set Global Ply ID 

• Insert a Ply, Ply Material, or Layup

• Icons for both modes

• Add Layup – adds layup(s) to editor

• Toggle between one or two lines of text

• Toggle between Global Ply/Insert modes

• Copy to Clipboard

• Send to Excel



Laminate Enhancements – MultiLayup Editor – Set Global Ply ID

Set Global Ply ID mode

• Can only be used successfully when only 

Plies and/or Ply Materials are highlighted in 

all selected layups

• Global Ply IDs can be assigned one at time, 

unassigned in bulk, or automatically created 

using a user-specified increment

• Unique Icons for Set Global Ply ID Mode

• Add or Update Global Ply

• Remove Global Ply

• Fill Selected Plies to Create New Global 

Plies

• Global Ply Manager

• Show Global Ply – Highlights elements 

which use global plies in graphics window



Laminate Enhancements – MultiLayup Editor – Insert Ply, Ply Material, or Layup

Insert Ply, Ply Material, or Layup mode

• Will only insert Ply, Ply Material, or Layup at 

specified location for layups which have 

specific plies highlighted in the table

• Unique Icons for Insert Ply, Ply Material, or 

Layup Mode

• Add item at Top of each qualified layup

• Add item Above Selected row of each 

qualified layup

• Add item at Bottom of each qualified layup

• Delete highlighted plies – When an entire 

row is highlighted, everything highlighted in 

the table will be deleted



Simulation Entities



Kinematic Joints – Overview

1D Connection Entities that allow for analysis of Flexible 

Multi-Body Dynamic Systems in SOL402 and ANSYS

(future support planned for ABAQUS)

• Aerostructures 

• Gas turbines 

• Industrial Robots 

Joint Definition

• Connect two nodes 

• 6 relative Degrees-Of-Freedom (DOF)

• Kinematic constraints imposed on displacement and 

rotational DOF to create different joint types 

• Revolute, Slider, Universal, etc. 

• Local CSys Definition at nodes



Kinematic Joints – Simcenter Femap Interface

Solver-Neutral Interface 

• Kinematic Joints are a new “Simulation Entity” that provide a 

single unified interface to the joint elements in SOL402 and 

ANSYS (future support planned for ABAQUS)

• SOL402 – CJOINT/PJOINT/PJOINT2

• ANSYS – MPC184/SECTYPE,ID,JOINT,(Joint Type)/ 

SECDATA/SECJOINT/SECNUM/SECLOCK/SECSTOP/ 

SECJ,TB

Supported Behaviors

• Joints with Coincident Nodes 

• Revolute, Spherical, Fixed, Universal, Constant Velocity

• Slider Joints

• Inline, Slider, Cylindrical, Slider-Universal, Screw

• General Joints – User defines DOF and other options. 

Added for 2022.2, ANSYS only



Kinematic Joints – Benefits of using Joint Connections

• When multiple solvers are supported, provides Solver-Neutral Approach to Defining Joints and 

attachments to motion bodies via Finite Element Entities, Geometric Entities, or Both

• Connection to motion bodies automatically expanded on export to different solvers (Simcenter Nastran –

RBE2s or RBE3s, ANSYS – MPC184s, ABAQUS – TBD) 

Revolute JointMotion Body 1

Connections automatically 

generated on export
Motion Body 2



Kinematic Joints – Properties

Additional Joint Properties (General tab - ANSYS)

• Solver Expansion Options – Currently not used

Additional Joint Properties (ANSYS tab)

• Reference Lengths/Angles – Writes values to 

SECDATA entries

• Locks – Writes values to SECLOCK entries

• Stops – Writes values to SECSTOP entries

• Misc Data – Writes values to SECJ and TB entries



Monitor Points – Overview

Allow analysts to print labeled output for Integrated 

Loads on Structural and Aerodynamic models

Model->Simulation Entities->Monitor Points

Creation, editing, previewing, and management via 

NASTRAN Monitor Point Manager

Available in Simulation Entities branch of Model Info 

Tree and a symbol is drawn in graphics window at 

summation point for location-based types

Types Supported in v2020.1 (initial release):

• NASTRAN Aerodynamic Control Monitor Point 

(MONPNT1) 

• NASTRAN Structural Monitor Point (MONPNT3)

New type added for v2022.2!

• NASTRAN Element Monitor Point (MONPNT2)



Monitor Points – NASTRAN Element Monitor Point (MONPNT2) 

NASTRAN Element Monitor Point

• Writes MONPNT2 bulk data entry for Simcenter 

Nastran and MSC Nastran 

• Defines load monitor point at named element and 

outputs component of stress, strain, or force

• Created and edited using the NASTRAN Element 

Monitor Point dialog box

• Two Way to Select Output

• Output Vector Selection – choose Femap Output 

Vector ID from drop-down and table is populated 

automatically for selected elements

• Manual Selection – choose options using output 

type, element type, and component drop-downs 

to populate table for selected elements



User Interface Updates



Element Update

Modify->Update Elements->Line Element Offsets

• Dialog box reorganized by offset method

• Allows user to pick exactly how they want to 

offset line elements which was sometimes not 

clear in previous versions

• For some methods, eliminates need to enter 

values in additional dialog boxes

• Added the ability to offset a specified length 

along the user-defined vector when using the 

Around Vector method

• Can be combined with the Radial Offset value



Grouping and Selection

• New Group Commands to include geometric 

entities in a group based on an associated node 

or element

• “Group, Point, From Node”

• “Group, Point, From Element”

• “Group, Curve, From Node”

• “Group, Curve, From Element”

• “Group, Surface, From Node”

• “Group, Surface, From Element”

• “Group, Solid, From Node”

• “Group, Solid, From Element”

• Similar options added to Method^ menu in 

Standard Entity Selection dialog box for Points, 

Curves, Surfaces, and Solids



Grouping and Selection

• API Selections Tools submenu has 

been added to Pick^ menu of the 

standard entity selection dialog box

• Allows API script to be executed to 

add or remove items from the 

selection while dialog box is open.

• Submenu works like Custom Tools 

and User Tools menus directory to 

store API scripts can be set on the 

Library/Startup tab of Preferences

• Unique API calls added which should 

be in every script used for this purpose

• feStartSelectionTool

• feEndSelectionTool

• feAbortSelectionTool



Contour/Criteria Legend – No Labels Options

Option to no display labels on the Contour/Criteria Legend using either Contour Colors or View Color

Pair either option with new methods on User Defined Graphics API Object to create custom Labels



Analysis Set Manager – Find functionality

Find functionality in Preview Analysis Input File dialog box to search previewed input for text



Modern Online Help System

• HTML help (implemented v2022.1, improved v2022.2)

• Femap can access help on Siemens Support Center

• Can also be installed locally or on a network server

• Fully searchable

• Browser bookmarks

• Still in legacy format

• API manual

• Custom Tools

• VisQ

• More Resources (PDFs)



Solver Support



Solver Support – Nastran Solvers – Aeroelastic Response

Support for Aeroelastic Response (SOL 146)

• Added three new analysis types:

• 31..Aeroelastic Frequency Response

• 32..Aeroelastic Transient Response

• 33..Aeroelastic Random Response

• NASTRAN Dynamic Analysis dialog box is 

available in all three analysis types to specify 

options for Modal Transient and Modal 

Frequency Response

• New options added to NASTRAN Aerodynamic 

Data dialog box for all three analysis types:

• Mach Number (MACH)

• Dynamic Pressure (Q)

• Gust Load (GUSTAERO)



Solver Support – Nastran Solvers – Aeroelastic Response

Support for Aeroelastic Response (SOL 146)

• Ability to enter Power Spectral Density Factors 

using Gust PSD Input added to NASTRAN 

Power Spectral Density Factors (SOL 146) 

dialog box for Aeroelastic Random Response

• Loads (Aerodynamic) drop-down added to 

Boundary Conditions dialog box which allows 

separate loads for the mechanical and 

aerodynamic portions of the model

• An Aerodynamic Vertical Gust Load can now 

be specified as a Body Load in any Load Set 

which can be specified using this drop-down



Solver Support – Nastran Solvers – Aeroelastic Response

Animation of Aeroelastic Transient Response with Gust Load of System-Level Model



Solver Support – ANSYS

Added read and write support for ANSYS MPC184 Joint Elements, including options for 

SECDATA, SECJ, TB, SECLOCK, and SECSTOP.



API



API

• For Laminate Updates (Ply Material and Layup Objects):

• Added Ply Material, along with applicable Properties and Methods, to allow programmatic 

access to new Ply Material entity added for 2022.2

• Added OnOff, vOnOff, and IncludeOffPlys Properties to the Layup Object. Also, updated 

thickness, vthickness, angle, vangle, matID, vmatID, globalply, vglobalply, failuretheory, 

and vfailuretheory to work with updated Layup Manager dialog box. Finally, added 

AddPlyMaterialPly, AddLayupPly, AddMatchedPlys, GetPlyInfo, GetAllPlyDefinition, 

MaterialsUsed, GlobalPlysUsed, and PlyMaterialsUsed Methods to the Layup Object.

• For Nastran SOL 146 Support

• Added NasAeronPARAMgustaero, NasAerodPARAMmach, and NasAerodPARAMq to 

Analysis Manager Object. Also, added IsGust, GetCorrelateGust, and PutCorrelateGust

methods to the Analysis Manager Object

• Added BodyGustOn, BodyGustWG, BodyGustX0, BodyGustVelocityOpt, BodyGustVelocity, 

BodyGustAppliedNode, and BodyGustFunction to the Load Set Object.



API

• For Nastran Elemental Monitor Points:

• Added NasMonitorElemEnabled to Analysis Manager Object

• Added NasCaseMonitorElemEnabled to Analysis Case Object

• Added AddManualContribution, GetElemContributions, SetManualContributions, 

ClearElemContributions, GetAtIndex, and SetAtIndex to Monitor Point Object.

• For OEM Customers:

• Added GetAllArray, GetAllAttrArray, PutAllArray, and PutAllAttrArray to the Curve Object

• Added GetAllArray, GetAllAttrArray, PutAllArray, and PutAllAttrArray to the Surface Object

• Added GetAllArray and PutAllArray to the Material Object.

• Added GetAllArray, GetFlagArray, PutAllArray, and Put FlagArray to the Property Object

• Added SetOpenGLTransformationSpace, GetOpenGLTransformationSpace, 

CollectorContourLegendText, and CollectorAddTextContourLegendLocations to User 

Defined Graphics Object.


